
Created in COMSOL Multiphysics 5.6
MOSFET w i t h  Mob i l i t y  Mode l s
This model is licensed under the COMSOL Software License Agreement 5.6.
All trademarks are the property of their respective owners. See www.comsol.com/trademarks.

http://www.comsol.com/sla
http://www.comsol.com/trademarks/


This model shows how to add several linked mobility models to the simple MOSFET 
example.

Introduction

The response of the charged carriers to electric fields and their subsequent momentum loss 
due to a host of physical processes can be a very important factor in semiconductor 
simulation. There are numerous physical processes that act to remove momentum from 
charged carriers within a semiconductor device. These include, but are not limited to, 
lattice vibrations (L), ionized impurity ions (I), carrier concentrations (C), and surface 
effects (S). The effect of these individual microscopic processes are generally combined 
into the macroscopic quantity, the carrier mobility, found in the transport equations. In 
addition, the presence of large electric fields (E) within the device can serve to significantly 
reduce the carrier mobility in those regions. 

In some cases a constant value for the mobility can be used, measured for a particular 
semiconductor material. However, in many devices, the physics demands that you model 
the effects described above as they can drastically alter the value of the carrier mobility in 
certain parts of the device.

This model adds three mobility models to the basic MOSFET model to explore the effect 
of these processes on the I-V characteristics. Please review the MOSFET model in the 
Application Libraries first.

Model Definition

The geometry and operation of the device are discussed for the DC Characteristics of a 
MOS Transistor (MOSFET) model.

There are several mobility models available for use within the Semiconductor interface. 
They are provided to cover all the basic processes and physics that may be present in your 
model that may affect the carrier mobility.

In general, the correct use of mobility models in semiconductor simulations is not 
straightforward. There exist several families of models that need to be used and combined 
in particular ways. The implementation within the Semiconductor interface aims to 
simplify their use by providing a mechanism to “chain” mobility models together in the 
appropriate way. In addition, flexibility is provided so that custom or complex user-defined 
mobility models can be implemented with ease.
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In this tutorial model three mobility models are added and linked together. The mobility 
models are listed below together with a small description. For more information, see the 
“Mobility Models” theory section in the Semiconductor Module User’s Guide.

Arora mobility model (LI)
The Arora mobility model (Ref. 1) is an empirical model that aims to model both phonon 
(L) and ionized impurity scattering (I). This model calculates carrier mobilities based 
solely on provided model parameters, therefore it can be used on its own or as an 
intermediate step for other mobility models. In this example it is used as an input into the 
Lombardi surface mobility model.

Lombardi Surface Mobility Model (S)
The Lombardi surface mobility model (Ref. 3) adds surface scattering (S) resulting from 
surface acoustic phonons and from surface roughness. Mobility contributions 
corresponding to these effects are combined with the input mobility using Matthiessen’s 
rule. This model is not a standalone model as it adjusts a supplied base mobility to include 
the described effects. The model accepts input mobilities of type L (power law mobility 
model), LI (Arora mobility model), or C (Fletcher mobility model (Ref. 2)) as well as a 
user-defined mobility. The Lombardi model is used as an input for the Caughey-Thomas 
mobility model.

Caughey-Thomas Mobility Model (E)
The Caughey-Thomas mobility model (Ref. 4) adds high field velocity scattering (E) to 
an existing mobility model (or to a constant input mobility). It also cannot be used as a 
standalone model, and it accepts input mobilities of type L (power law mobility model), 
LI (Arora mobility model), C (Fletcher mobility model), or S (Lombardi) as well as a user-
defined input mobility.

Once linked together, the model uses the output from the Caughey-Thomas model as the 
mobility used within the transport equations. This mobility contains contributions from 
all three models.

Numerous combinations of mobility models can be used and linked together depending 
upon the particular device being modeled. Simple, low bias p-n junction devices may only 
require lattice and ionized impurity models, whereas highly doped devices with high field 
regions close to contacts such as certain MOSFET devices may require the inclusion of 
carrier concentrations, surface effects, and high-field effect.
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Figure 1: Mobility model linking scheme and examples.

The mobility models link together as shown in Figure 1. A particular mobility model can 
be combined to include the physics of any mobility model below it in the table; mobility 
models cannot link to models above them in the table. Mobility models can be skipped as 
you go down the table if that process is not important. The tutorial model links the 
mobility models as shown in example 2.

Some of the mobility models are highly nonlinear, in particular the Fletcher, Lombardi, 
and Caughey-Thomas models. As a result, the implementation of these models is designed 
such that their effect can be slowly introduced via a continuation parameter. This allows 
models to be solved with small contributions from these models initially, with a gradual 
ramp up to their full effect.

The model in this tutorial ramps the continuation parameter using the values 0.5, 1.0, and 
1.001. The last value is needed because of the use of the Previous Solution node used in 
the parametric solver node. This functionality results in much shorter solve times. In 
models where the electric field or doping is higher, the continuation parameter (Cp) may 
need to be ramped from 0 in smaller increments.

Results and Discussions

Figure 2 compares the I-Vd (Vg=2 V) characteristics with constant mobility and with the 
added mobility models.
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Mobility models generally model processes that remove or limit the momentum of the 
carriers, therefore a reduction in the drain current is expected when they are included in 
the model.

Figure 2: I-Vd (Vg=2V) characteristics comparing a model with constant mobility and with 
added mobility models.
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Application Library path: Semiconductor_Module/Transistors/mosfet_mobility

Modeling Instructions

R O O T

Open the existing MOSFET model (filename: mosfet.mph).

1 From the File menu, choose Open.

2 Browse to the model’s Application Libraries folder and double-click the file 
mosfet.mph.

Add the Arora mobility model. This models lattice and ionized impurity scattering 
effects. This model does not take any inputs other than the model parameters.

C O M P O N E N T  1  ( C O M P 1 )

In the Model Builder window, expand the Component 1 (comp1) node.

S E M I C O N D U C T O R  ( S E M I )

Semiconductor Material Model 1
In the Model Builder window, expand the Component 1 (comp1)>Semiconductor (semi) 
node, then click Semiconductor Material Model 1.

Arora Mobility Model (LI) 1
1 In the Physics toolbar, click Attributes and choose Arora Mobility Model (LI).

Next add the Lombardi surface mobility model. This mobility model takes the output 
from the Arora model as its input, along with additional model parameters.

Semiconductor Material Model 1
In the Model Builder window, click Semiconductor Material Model 1.
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Lombardi Surface Mobility Model (S) 1
1 In the Physics toolbar, click Attributes and choose 

Lombardi Surface Mobility Model (S).

To connect the output of the Arora model to the input of the Lombardi model, you 
select the appropriate values for the input mobilities within the Lombardi model.

2 In the Settings window for Lombardi Surface Mobility Model (S), locate the 
Input Mobilities section.

3 From the μn,in list, choose Electron mobility, Arora (semi/smm1/mmar1).

4 From the μp,in list, choose Hole mobility, Arora (semi/smm1/mmar1).

Next add the Caughey-Thomas mobility model. This mobility model takes the output 
from the Lombardi (or the Arora model) as its input, along with additional model 
parameters.

Semiconductor Material Model 1
In the Model Builder window, click Semiconductor Material Model 1.

Caughey-Thomas Mobility Model (E) 1
1 In the Physics toolbar, click Attributes and choose Caughey-

Thomas Mobility Model (E).

2 In the Settings window for Caughey-Thomas Mobility Model (E), locate the Input Mobilities 
section.

3 From the μn,in list, choose Electron mobility, Lombardi (semi/smm1/mmls1).

4 From the μp,in list, choose Hole mobility, Lombardi (semi/smm1/mmls1).

To connect the output of the Lombardi model to the input of the Caughey-Thomas 
model, again you select the appropriate values for the input mobilities.

Semiconductor Material Model 1
1 In the Model Builder window, click Semiconductor Material Model 1.

2 In the Settings window for Semiconductor Material Model, locate the Mobility Model 
section.

3 From the μn list, choose Electron mobility, Caughey-Thomas (semi/smm1/mmct1).
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4 From the μp list, choose Hole mobility, Caughey-Thomas (semi/smm1/mmct1).

The Lombardi and Caughey-Thomas mobility models are very nonlinear and therefore 
there effect needs to introduced gradually using the continuation machinery.

The continuation machinery allows the doping features and certain mobility and 
generation-recombination features to be introduced into the model slowly to ease 
solving.

Add a continuation parameter to be used in the continuation study.

G L O B A L  D E F I N I T I O N S

Parameters 1
1 In the Model Builder window, under Global Definitions click Parameters 1.

2 In the Settings window for Parameters, locate the Parameters section.

3 In the table, enter the following settings:

Set the interface to use the continuation parameter.

S E M I C O N D U C T O R  ( S E M I )

1 In the Model Builder window, under Component 1 (comp1) click Semiconductor (semi).

2 In the Settings window for Semiconductor, click to expand the Continuation Settings 
section.

3 In the Cp text field, type cp.

Now activate the continuation functionality within the mobility models and set them to 
use the interface continuation.

Lombardi Surface Mobility Model (S) 1
1 In the Model Builder window, under Component 1 (comp1)>Semiconductor (semi)>

Semiconductor Material Model 1 click Lombardi Surface Mobility Model (S) 1.

2 In the Settings window for Lombardi Surface Mobility Model (S), click to expand the 
Continuation Settings section.

3 From the Continuation type list, choose Use interface continuation parameter.

Caughey-Thomas Mobility Model (E) 1
1 In the Model Builder window, click Caughey-Thomas Mobility Model (E) 1.

Name Expression Value Description

cp 0 0 Continuation parameter
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2 In the Settings window for Caughey-Thomas Mobility Model (E), click to expand the 
Continuation Settings section.

3 From the Continuation type list, choose Use interface continuation parameter.

S T U D Y  1

Add a new stationary study. This will allow comparison between the currents with and 
without the mobility models.

R O O T

From the Home menu, choose Add Study.

A D D  S T U D Y

1 Go to the Add Study window.

2 Find the Studies subsection. In the Select Study tree, select General Studies>Stationary.

3 Click Add Study in the window toolbar.

4 From the Home menu, choose Add Study.

S T U D Y  3

Step 1: Stationary
Set up the study to sweep over the drain voltage, Vd. A range together with manual values 
will allow resolution only where it is needed.

1 In the Settings window for Stationary, click to expand the Study Extensions section.

2 Select the Auxiliary sweep check box.

3 From the Sweep type list, choose All combinations.

4 Click Add.

5 In the table, enter the following settings:

Now add the continuation parameter to the sweep. The field-dependent mobility 
models are very nonlinear and difficult to solve directly. In the following steps we will 
add a Previous Solution node in the solver sequence to fix the fields at the values from 
the previous parameter value. With the values of 1 and 1.001 for the continuation 
parameter cp, when solving the case of cp = 1.001, the fields take on the values at 
cp = 1.

Parameter name Parameter value list Parameter unit

Vd (Drain voltage) range(0,0.1,0.5) 0.75 1 3 5 V
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6 Click Add.

7 In the table, enter the following settings:

Tell the solver to reuse the solution for the previous step between the continuation 
sweeps.

8 From the Reuse solution from previous step list, choose Auto.

Our initial solution (Vd = 0V, Vg = 2V) has actually been solved for in study 2.

9 Click to expand the Values of Dependent Variables section. Find the 
Initial values of variables solved for subsection. From the Settings list, choose 
User controlled.

10 From the Method list, choose Solution.

11 From the Study list, choose Study 2, Stationary.

12 From the Parameter value (Vd (V),Vg (V)) list, choose 1: Vd=0 V, Vg=2 V.

Solution 3 (sol3)
1 In the Model Builder window, expand the Study 1 node.

2 Right-click Study 3 and choose Show Default Solver.

3 In the Model Builder window, expand the Solution 3 (sol3) node.

4 In the Model Builder window, expand the Study 3>Solver Configurations>

Solution 3 (sol3)>Stationary Solver 1 node.

5 Right-click Parametric 1 and choose Previous Solution.

6 In the Settings window for Previous Solution, locate the Previous Solution section.

7 Under Variables, click Add.

8 In the Add dialog box, in the Variables list, choose 
Electric field parallel to electron current density (comp1.semi.smm1.mmct1.Epn), 
Electric field parallel to hole current density (comp1.semi.smm1.mmct1.Epp), 
Electric field magnitude perpendicular to electron current density (comp1.semi.smm1.mml

s1.Edn), and 
Electric field magnitude perpendicular to hole current density (comp1.semi.smm1.mmls1.E

dp).

9 Click OK.

Parameter name Parameter value list Parameter unit

cp (Continuation parameter) 1 1.001
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10 In the Study toolbar, click Compute.

Next, duplicate the I-V plot and compare the current obtained with and without the 
mobility models.

R E S U L T S

Id vs. Vd 1
1 In the Model Builder window, right-click Id vs. Vd and choose Duplicate.

2 In the Settings window for 1D Plot Group, locate the Data section.

3 From the Parameter selection (Vg) list, choose From list.

4 In the Parameter values (Vg (V)) list, select 2.

Global 2
1 In the Model Builder window, expand the Id vs. Vd 1 node.

2 Right-click Results>Id vs. Vd 1>Global 1 and choose Duplicate.

3 In the Settings window for Global, locate the Data section.

4 From the Dataset list, choose Study 3/Solution 3 (sol3).

5 From the Parameter selection (cp) list, choose From list.

6 In the Parameter values (cp) list, select 1.001.

7 Locate the x-Axis Data section. From the Axis source data list, choose Vd.

8 In the Id vs. Vd 1 toolbar, click Plot.

9 Click to expand the Legends section. From the Legends list, choose Manual.

10 In the table, enter the following settings:

Global 1
1 In the Model Builder window, click Global 1.

2 In the Settings window for Global, locate the Legends section.

3 From the Legends list, choose Manual.

4 In the table, enter the following settings:

5 In the Id vs. Vd 1 toolbar, click Plot.

Legends

Vg=2, mobility models

Legends

Vg=2, constant mobility
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